
    


    
    Top
   
    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 




          
          
            
              
                
                  
    More Word Features

    
      	
              
                  Organize Pages in Word

              

              
                  	Remove Page Numbers in Word
	Insert Landscape Page in Word
	Delete Blank Page in Word
	Split Pages in Word
	Rearrange Pages in Word
	Rotate Page in Word
	Insert Page in Word
	Change Margins in Word


              

          
	
            
                Signature in Word

            

            
                	Write Signature in Word
	Draw Signature in Word
	Put Signature in Word
	Insert Signature in Word Mac
	Insert Signature in Word
	Electronically Sign Word
	Make Electronic Signature in Word
	Do Electronic Signature in Word
	Create Electronic Signature in Word
	Digitally Sign Word
	Add Digital Signature to Word
	Insert Digital Signature in Word
	Create Digital Signature in Word


            

        
	
          
              Form in Word

          

          
              	Create Word Form Template
	Create a Form in Word
	Copy Table from Excel to Word
	Convert Word Table to Excel
	Split Table in Word
	Table of Contents in Word
	Rotate Table in Word
	Merge Cells in Word
	Create Fields in Word
	Insert Field in Word


          

      
	
        
            Track Changes in Word

        

        
            	Track Changes in Word Mac
	Accept Track Changes in Word
	Remove Track Changes in Word
	Use Track Changes in Word
	Turn off Track Changes in Word


        

    
	
        
            Insert Files in Word

        

        
            	Insert PDF into Word
	Insert Word Document into Word
	Insert File into Word
	Insert Excel into Word


        

    
	
        
            Word Editors

        

        
            	Word Editors
	Online Word Editor
	Word Editing App


        

    
	
        
            More Tips about Word

        

        
            	Merge Word Documents
	Clear Formatting in Word
	Reduce Space Between Lines
	Insert Index in Word
	Insert Roman Numerals in Word
	Add Border in Word
	Word Drop Down List
	Make a Word Document Fillable
	Add Checkbox in Word
	Insert Citation in Word
	Alignment in Word


        

    


  Try It Free    Try It Free  Try It Free
    

  

                

              

              
                  
            

          
          


    
		
		  	  	    
      
    
		
      
        
          How to Write Signature in Word

        

      

      
        

          
            
              
            

            
              
                
                  
                    Margarete Cotty

                  

                

                
                  
                    2024-01-08 18:46:10 • Filed to:
                    Word Tips and Tricks
                    • Proven solutions
                  

                

              

            

          

          
	How to write signature in word is a process which is highly advised to the users that use the Word professionally. It is highly advised to write signature in word without any problem if you follow the process which is mentioned as under. If you want to know how to write a signature on word it is highly advised to make sure that you go through the process which is mentioned as under. The process is very simple and will let you know that the best outcome is generated. It will also make sure that you never deviate from the path.


 

		
			Part 1: How to Write Signature in Word  
		
	
			Part 2: Advantages of PDF Format 
		
	
			Part 3: How to Write Signature in PDFs  
		





	How to Write Signature in Word



	The process which you need to follow is mentioned as follows. The best part of the process is that it is completely word based.


	
		Write your name on a piece of paper and scan it to save the image on your computer.
	
	
		Open a word document, click the "Insert" tab to start the process.
	
	
		Write down the text under the signature which you want to add and then click the "Quick Parts".
	
	
		In the next winnow you need to fill the fields which pop up. The Create New Building Block window is very important.
	
	
		Name the signature which you want to add to your document. Give a name which you can easily remember.
	


		 
	

		
		In the "Insert" tab once again to add the signature to the doc.
	
	
		Click the "Quick Parts" once again to proceed.
	
	
		Select the signature from auto text that appears.
	


		 
	

		
		Click "Insert" > "Signature line" to proceed with the second step to add the sign to the word doc.
	
	
		Once the signature setup window is filled you need to press OK. A signature line will be added to the document as below. It completes the process in full.
	


		 
	


 



	Advantages of PDF Format



	The PDF format is one of the securest one on earth when it comes to editing or changing the file content. With this format it is not at all difficult to make sure that the file changes are detected and traced. The best part of the format is that it also allows the users to get the readers which are free of charge. It means that you don’t have to worry about accessing the PDF files as it is very easy. The PDF format has the best readability and it means that it is equally accessible over all the devices. The format is universal and can be accessed over any OS which you are using without any trouble.



	Wondershare PDFelement - PDF Editor
 is a program which has made the PDF manipulation very easy. It is highly rated and therefore regarded as one of the best programs of all time. The best part of the program is that it allows the users to overcome the problems which PDF format encounters in general. With this program it is very easy to make sure that the PDF files are processed as per need and demands of the users. PDFelement can be regarded as a valuable contribution to your system and it is highly rated and the credit goes to its easy interface.
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	Features of the program: 


	
		The program  also ensures that the data is extracted from the PDF files. Export all the data  from hundreds of scanned documents or forms.
	
	
		PDF  protection has never been as easy as it is with this program. With this program  you can easily secure your PDFs with password protection.
	
	
		The PDF  editing has been taken to a new level by this program. It has a robust editing  engine that empowers computer users to edit any of their documents.
	
	
		The PDF can  be altered in a very customizable and personalized manner. You can easily approve  and sign documents digitally.
	



	 


 



	How to Write Signature in PDFs



	The process which you need to follow is mentioned as follows. You need to make sure that the steps are followed as they are to get the best outcome.



	Step 1. Import the PDF



	Press the "Open File" tab on the main interface to proceed with the process by importing the PDF files to the software.



	 



	Step 2. Create Custom Stamp



	Use "Create Custom Stamp" tool in the "Comment" tab to make sure that you import the signature to the program. It can be done by scanning the page where you have written your name and save it to an image on your local drive.



	 



	Step 3. Add Custom Stamp



	Then go to the "Stamp" tool to choose the customized signature that you have added and proceed with the process.
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